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Overview of AniMap 3.0 
 
 
  AniMap is a program which shows maps for each of the 50 states with all the county 
boundary changes that have taken place since the first settlements. A number of 
controls are available which allow you to quickly display the map for any given year, or a 
Run mode where you can view the changes in sequence either backward or forward in 
time. 
 
To assist you in viewing the changes for a particular place, there are markers (available 
in a choice of designs and colors) which you can place on the map at any chosen spot. 
You may put up to 50 of these on any one map and even save a set of markers to use 
in a future session. 
 
A variety of overlays let you view the current county and state boundaries over the map 
for any year. You may also save any map to use as an overlay on any other if you have 
two specific years you want to compare. Overlays for latitude and longitude grids, 
township/range data, railroads and waterways are also available. A system has been 
built in which allows you to view the latitude and longitude coordinates for the point 
where the cursor appears on the map. This will let you place a marker at any set of 
coordinates. This system also includes a Mileage Mode which lets you measure the 
distance between any two of the markers you have placed. 
 
SiteFinder is a database containing more than one million listings for cities, towns and 
many other places of historical interest in the U.S., giving the state and county where 
they are located plus the latitude-longitude coordinates. This new edition also contains a 
file with the locations of county courthouses and lists locating more than 100,000 
cemeteries, 165,000 churches and 167,000 schools. (This database may be accessed 
by selecting "SiteFinder" from the AniMap options menu). 
 
SiteFinder contains a powerful Search feature which will allow you to locate places of 
interest, and a "Pluck" option that will build you a list (up to 20 items) of places to mark 
on your maps. When you exit SiteFinder, you will be returned to AniMap where you may 
access your Pluck List and plot the locations you have selected with a double click of 
your mouse. This will place a marker for the chosen location and include the name as 
well. 
. 
Maps from AniMap may be printed in color or black and white in a choice of formats. 
You may also export the maps and use them as illustrations in other software.  
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Map Selection 
 

 
When you first activate AniMap, a Welcome Screen appears with a Pick State List. Double-clicking the left 
mouse button on the state of your choice will bring up the earliest map for the state you selected. 
 
Notice that there are some items on the list in addition to the 50 states. Railroad maps with year-to-year 
progress are furnished for the New England states. Also a map of  
Canada showing the development of the provinces and territories and an Ontario map showing 
development of the counties and other sub-province locations. Two maps of the full United States are 
included, one showing the boundaries of states and territories beginning with the 13 colonies. The other 
United States map shows all the counties year by year.  
 
To change to another state, Pick OPEN from the FILE menu. This will close the state you have been 
working on. If you don't want to close out that state, minimize the AniMap window by clicking on the minus 
sign (-) in the upper right corner of the screen. Then open AniMap again and you will be able to look at 
one or the other as you want. Please note that the maps are not all to the same scale.                              
 

 
 
 
 
 
 

 4



 
 
 

Displaying the Maps 

 

A new feature in version 3.0 will adjust the map size to your screen. Three sizes are available and the 
one that best fits your screen resolution will be automatically selected. You may change this at any time 
by selecting from the VIEW menu at the top of the screen. If you should choose the 1280x960 size and it 
does not fit your screen, it will still be displayed and can be viewed by using the arrow keys to move from 
one quarter of the map to another. 

 
All the maps are sized to fit the screen, and therefore are not to the same scale. Because of this, the 
boundaries of two adjoining states displayed side by side will not mesh. 
Several viewing options are controlled by buttons on the screen: 

 5



NEXT displays the next map in chronological order. 
 
BACK reverts to the previous map. 
 

RUN displays the maps in sequence something like a motion picture. Clicking on the "C" box will skip any 
years for which there were no changes.  

 
FWD runs the display in chronological order,  
 
REV runs in reverse chronological order. 
                                                                  
1, 2, 3, and Q control the Run speed. The numbers indicate the approximate number of seconds a map is 
displayed before moving on to the next. Q (for Quick) moves through the display very rapidly. Clicking on 
the circular (Radio) buttons will select these. 
 
FLASH will alternately display two consecutive maps for easy comparison. Clicking on the "C" box before 
selecting flash will alternate the display between the selected map and the modern map 
 
STOP will halt either the RUN or FLASH operation. All the other controls are inoperative until you have 
stopped these functions. Sometimes, the STOP key will not work during a run sequence. In this case, 
press S on the keyboard. 
 
RESTART returns you to the first map in the series for that state. 
 
A map for a specific year may also be selected by double-clicking the left mouse button on any of the 
years in the Go To >> box. 

                          

Each map also includes a Narrative box (at the upper right in this illustration) which lists all the changes 
affecting county boundaries that took place since the previous map: 
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County Codes 

 

                              
              
Limited space makes it necessary to use abbreviations for county names on the maps. The County 
Codes box provides a list of these abbreviations.  
At the top of the list you will find a heading for <current list> or <full list>. The Current List shows only 
the counties in existence on the map you are displaying. Full List shows all the counties that have ever 
existed for that state. A double-click with the left mouse button in the County Code box will toggle 
between Current and Full List. 
 
Double-clicking on one of the county names will bring up a box giving the county seat, date the county 
was formed and the approximate location on the map. Some counties located outside the present 
boundaries of the state will not have this information available. 
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Legend and Definitons 

 
 

Map Feature Definitions                     
 
                                  
UNORGANIZED COUNTIES.  These are counties whose boundaries have been established by the 
legislature, but do not have an established government. Usually, they are attached to an adjacent or 
nearby county which takes care of government services. These are indicated on the maps. 
                         
NON-COUNTY AREAS. Especially in earlier times, there were areas within a state which were not 
assigned to any county. These are shown on the maps with a unique dotted pattern. Indian lands are also 
included in this category. 
 
EXTRA-TERRITORIAL COUNTIES. In some cases, states established counties that were outside the 
accepted state boundaries, sometimes for the purpose of laying claim to these areas. These are indicated 
with green boundary lines on the maps. 
 
INDEPENDENT CITIES. Virginia has established a number of "Independent Cities" which are not part of 
any county. These are shown using a special color coding on the maps.  
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Placing Markers on Your Maps 
 

     
 

Shortcut Key: K 
 

 
                                     
  
MARKERS: To mark reference points on a map, you have a selection of 13 different designs which are 
color-selectable. Up to 50 of these markers may be placed on any one map (all alike or mixed).  
       
Selecting MARKERS from the Options Menu (K is the shortcut key for this) will bring up a box showing 
the designs. Select one by clicking on the circular button (Radio button) below it. Clicking the buttons in 
the Color Box will cycle through the available colors. When you have made your selection, click OK. 
 
To set the markers, use the right mouse button to activate the marker cursor. Move the marker to where 
you want it, then click the left mouse button. You can then continue placing markers following the same 
process or return to the Marker Box to choose another design or color. 
 
You may also add labels to your markers to indicate town names or other places of special interest. See 
the section on Marker Labels. 
 
An alternative which allows more control over placement of the markers is to press the INSERT key to 
activate the marker cursor, move the marker using the Arrow Keys, then press INSERT again to place the 
marker. If you are not using a mouse, the marker process may be started by pressing the INSERT key, 
moving the cursor with the Arrow Keys, then pressing INSERT again to place the marker. 
 
To remove a single marker, point to it with the cursor and click the left mouse button again. If you want to 
remove all the markers, bring up the Marker Box and click on ERASE ALL.  
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If you want to save a set of markers you have on the screen, bring up the marker box and click on SAVE. 
RETRIEVE will bring them back at any time. Repeated clicking on RETRIEVE will cycle through and show 
any additional marker sets you have saved for that state. 
 
CLEAR MEMORY will erase the marker set you presently have displayed on the screen. There is a limit 
of 10 marker sets that can be saved, either for one state or all states in combination. If all the marker 
memory slots are filled, SAVE will not appear in the box and you will see a list of the states for which 
markers are saved to help you find saved sets and possibly clear some space. 
 
[Note for advanced users: The file in which the marker sets are saved is ANIMAP.DAT. You can create a 
library of marker sets by saving a copies of this file under other names, then bringing them back as 
ANIMAP.DAT. Do not simply rename ANIMAP.DAT; this file must be present for the program to run 
correctly.] 
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                                 Overlays                                                   

 

Shortcut Key: Y 

 
        

Selecting Overlay from menu bar (Y is a shortcut key to do this) will bring up a box with a number of 
choices. Please note that RUN, NEXT and BACK may not operate properly with an overlay on the screen: 
 
       
MODERN MAP: This will overlay a map of the present boundaries over any other map you are displaying 
on the screen. 
 
SAVE MAP: If you want to overlay a map other than the modern map on another, you can use this option 
to save the map you want to use as an overlay. Then you can bring up the map you want to have below 
the overlay and select USE SAVED MAP to display it. 
 
LATITUDE-LONGITUDE: This option will overlay a grid showing latitude and longitude coordinates over 
the map you have displayed. 

 
IMPORT OVERLAY: AniMap  will allow you to import overlays in a variety of colors on any of the maps 
generated by the program. This version of AniMap includes four types of Import Overlays for each state: 
 
RAILROADS: This overlay shows railroad lines in existence in the early 1970s (the time for which this 
data was available in a form that could be used for mapping). 
 
RAILROADS - CODED: In addition to the above, this overlay shows the lines abandoned since the early 
1970s in varying colors and with names. This overlay must be viewed in opaque mode. 
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RIVERS & STREAMS: This overlay includes waterways of any consequence. Small creeks and streams 
could not be included, nor is there space to include names. 
TOWNSHIP-RANGE: Township/Range grids are shown for all the public land states. To find a particular 
location, it will be necessary to count squares from the base line and meridian. This feature is explained 
more fully in help section for Township-Range Information. Only one overlay at a time can be used. When 
there is an overlay available, the Overlay Dialog Box will include an item for IMPORT OVERLAY. If more 
than one overlay is available, there will be a button to the right of the word Import. Clicking on this button 
will cycle through the available overlays.  
 
OPAQUE MODE will overlay a map or grid which will completely cover the underlying map. Color options 
are not available in this mode. 
 
TRANSPARENT MODE will use a color-selectable overlay through which your map may be viewed. 
Clicking the buttons in the color box repeatedly will cycle through the available colors. 
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Township & Range Overlays 

 
 

Note: The Township & Range Overlays are accessed by selecting "Import" in the overlay menu. 
See the help topic for Overlays for further instructions. 

 
 
Overlays are provided for the 29 Public Land Survey states.  These comprise all states admitted from 
1803 (Ohio) onward, excepting Maine, which had been part of Massachusetts, and Texas, which retained 
ownership of its own public lands when admitted in 1845, and had its own survey system. 
            
The township and range lines in these overlays are in black for every fifth line, and in blue for the others.  
Thus, when viewed in transparent mode, every fifth line will appear, and in opaque mode, the entire 
pattern will be present.  At the opposite ends of each fifth line are numbers, in black, designating the 
township or range number.  There are gaps in the grid pattern in some of the earlier settled states, which 
provides a clue to which areas were already settled by the time the survey was made, as these areas 
were already surveyed by the tradition "Metes and Bounds" method. 
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  Township numbers run from north to south, and range numbers from east to west.  The numbers are 
referenced to "Base Lines" for the township numbers and to "Meridians" for the range numbers.  There 
are many different coordinate systems, and often two different systems apply in different part of the same 
state.  A location will usually specify to which coordinate system it applies by the name of the Meridian. 
 
To aid the user in locating to which coordinate system a location is referenced, given below is a 
description of the system or systems for each state.  Examination of the overlay map will make clear 
which grids are designated by which names: 

 
ALABAMA: 
Northern Part:  Huntsville Meridian (est.1807).  All townships numbered south from base line, which is northern 
boundary of state. 
Southern Part:  St. Stephens Meridian (est. 1805).  Base line is southern boundary, townships numbered north for 
most of area, south into Mobile area. 
 
ARIZONA: 
Most of state: Gila and Salt River Meridian (est. 1865). 
The northeast corner of the state has a separate survey based on the Navajo Meridian.  In some areas, there is 
overlap, and locations might be referred either to the main US or the Navajo Survey. 
 
ARKANSAS: 
Fifth Principal Meridian (est. 1815) 
 
CALIFORNIA: 
Central and Northern Part:  Mt. Diablo Meridian (est. 1851) 
Southern Part: San Bernardino Meridian (est. 1852) 
Northwestern Corner: Humboldt Meridian (est. 1853) 
 
COLORADO: 
Most of state: 6th Principal Meridian (est. 1855) (ranges numbered 40-103) 
Southestern part: New Mexico Principal Meridian (est. 1855) 
Small section in west: Ute Meridian (est. 1880) 
 
FLORIDA: 
Tallahassee Meridian. (est. 1824).  There is a one township northerly offset in the baseline from Range 17 west in the 
panhandle. 
 
IDAHO: 
Boise Meridian. (est. 1867) 
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ILLINOIS: 
Most of state:  3rd Principal Meridian (est. 1805) 
West of Illinois River and 3rd Principal Meridia:  4th Principal Meridian (est. 1815) 
 
INDIANA: 
Most of state:  3rd Principal Meridian (est. 1805) 
Slice in southeast corner:  This section, lying east of an Indian Treaty line, is a westward extension of the Miami River 
Base survey in Ohio.  It was surveyed privately prior to 1796, and townships are numbered north from the Ohio River. 
 
IOWA: 
5th Principal Meridian (est. 1815) 
 
KANSAS: 
6th Principal Meridian (est. 1855) 
 
LOUISIANA: 
Most of state:  Louisiana Meridian (est. 1807) 
East of Mississippi River:  St. Helena Meridian (est. 1819) 
 
MICHIGAN: 
Michigan Meridian (est. 1815) 
 
MINNESOTA: 
West and south: 5th Principal Meridian (est. 1815).  Extends north from Iowa. 
East and north of Mississippi River:  4th Principal Meridian (est. 1815).  Extends west from Wisconsin. 
 
MISSISSIPPI: 
Central section:  Choctaw Meridian (est. 1821) 
North and east section:  Chickasaw Meridian (est. 1833) 
Southern section:  Washington Meridian (est. 1803) This section extends north for eight townships along the 
Mississippi River west of Range 5E. 
 
MISSOURI: 
5th Principal Meridian (est. 1815) 
 
MONTANA: 
(7th) Principal Meridian (est. 1867) 
 
NEBRASKA: 
6th Prinicipal Meridian (est. 1855) 
 
NEVADA: 
Mt. Diablo Principal Meridian (est. 1851) 
 
NEW MEXICO: 
Most of state: New Mexico Principal Meridian 
Section in northwest corner:  Prior to 1936, a separate survey existed based on the Navajo Meridian.  This is shown 
in a separate user overlay. 
 
NORTH DAKOTA: 
5th Principal Meridian (est. 1815) 
 
OHIO: 
Ohio was the "laboratory" for the design of the Public Land Survey system, and inherits a pattern of many different 
coordinate systems.  The Land Ordinance of 1785 began the survey, and initially private land companies did the 
surveying, with no standardization of method for numbering the townships.  In the sections bordering the Ohio River, 
the townships were numbered north from the river, so that the map shows each individual number for these. 
 
The beginning of the survey was the "Seven Ranges" section, in the southeast part of the state. 
Its numbering system was later extended west along the Ohio River to Virginia Military District, which was omitted 
from the survey.  This section, which had been surveyed by the traditional "Metes and Bounds" method starting in 
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1781, consisted of lands granted to Revolutionary War veterans. 
 
The strip immediately to the west of the Virginia Military District is called the "Symmes Purchase" (the southern four 
ranges) and "Between the Miamis".  This section departs from the usual in that the "Ranges" extend north and south, 
and the "Townships" from west to east based on the Miami River.  The numbering for the one or two townships along 
the Ohio River here is designated "FR1" and "FR2", for "Front Range". 
 
The section to the west of the Miami river is called "Miami River Base".   
 
The section in the center of the state with the diagonal northern boundary is the "US Military District", and was 
surveyed in five-mile square townships, instead of six-mile, which later became the standard.  The townships in this 
section are numbered regularly. 
 
North of the US Military District, the numbering reverts irregularly again to the Ohio River base, except for two 
maverick townships in the north central part which are referred to a "Muskingum River Base". 
 
The northeast corner of the state, the "Connecticut Reserve" was surveyed separately in five-mile townships.  Its 
numbering system extends into the "Firelands", the last five ranges (19-24) at the west end.   
 
The northwest part of the state follows a regular pattern based on the 1st Principal Meridian (est. 1819).  A narrow 
strip, slightly over one township wide, along the northern boundary with Michigan, is surveyed with reference to the 
Michigan Meridian. 
 
OKLAHOMA: 
Except for the Panhandle, reference to the Indian Meridian (est. 1870) 
The Panhandle is based on the Cimarron Meridian (est. 1881). 
 
OREGON: 
Willamette Meridian (est. 1851) 
 
SOUTH DAKOTA: 
East of Missouri River: 5th Principal Meridian (est. 1815) Extends west from Minnesota. 
West of Missouri River, northern part: Black Hills Meridian (est. 1878) 
Strip west of Missouri River along south boundary: Sixth Principal Meridian (est. 1855). Extends north from Nebraska. 
 
UTAH: 
Most of state: Salt Lake Meridian (est. 1855) 
Section in northeast corner: Unitah Meridian (est. 1875) 
 
WASHINGTON: 
Willamette Meridian (est. 1851) 
 
WISCONSIN: 
4th Principal Meridian (est. 1815) 
 
WYOMING: 
Most of state: 6th Principal Meridian (est. 1855) 
Section in west central area: Wind River Meridian (est. 1875) 
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Searching for Places in SiteFinder 
 
 
The SiteFinder database offers a numer of searching options. The fastest method is using the GO TO 
function: 

                             
Select GO TO from the menu, then type in up to five characters in the box provided then press the Enter 
key. This till take you the place in the list where your selection appears. If the location has more than five 
characters in the name, you may need to scroll down to find the one you want.The SEARCH function 
gives you a number of choices. If you know the name, or part of the name of a place, then select BY 
NAME from the pull-down menu. 

                                  
SEARCH BY NAME lets you fill in all or part of the name in the SEARCH FOR box and filling in the state 
and county are optional items. You may also want to fill in a feature type (Places, Cemeteries, etc.) or 
check the ALL button. If you do not check the CASE SENSITIVE box, the search will not care whether or 
not you have used any capital letters. In the SEARCH FOR box, you may use question marks as wild 
cards. For example if you not sure whether the name you want is Smith or Smyth, you can just type 
Sm?th and it will return a list including both spellings. Additionally, it will also list anything with smith or 
smyth as part of the name (for instance, Smithville). 
 
When you have a location you want to plot on a map, you may pluck it by either double-clicking it with the 
left mouse button, or highlighting it and selecting OPTIONS from the menu bar, then PLUCK from the 
pull-down menu. 
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SEARCH BY LOCATION requires that you first have a location plucked. When you select this type of 
search, the box will show you all the locations you have plucked.  You will need to highlight the one you 
want to use for your search, select a range of miles between 1 and 99 and the type of feature (church, 
cemetery, etc.) you want to find.                                                                 

                               

 
SiteFinder will return a list of locations that meet the criteria you selected. You may also pluck items from 
this list to plot on the maps.  
See also: Plotting Locations  
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Latitude/Longitude Locating                         
 

Shortcut Key: L 
 
 
 
SHOW LAT-LONG: This feature will allow you to place your markers very accurately on any point where 
the latitude and longitude are known. Selecting this option will place a large button reading "Latitude-
Longitude" on the screen. This button can be dragged to any position on the screen. 

 
Activating this feature is the same procedure you use to place a marker. Click the right mouse button to 
start it. The button will now show you the latitude and longitude for the present cursor position and will 
change as you move it. The left mouse button will drop the marker at the desired latitude and longitude. 
 
Since the display changes so rapidly, you may want to use the keyboard to fine tune the location. Get the 
approximate location with the mouse then use the right, left, up and down arrows to place it exactly. You 
can drop the marker by using the Insert key on your keyboard to avoid jiggling the mouse and changing 
the position. 
 
Once you move the cursor, the button will show the new latitude and longitude so you can place 
additional markers. 
 
Latitude and longitude coordinates are available from a number of sources including geographic servers 
on the Internet, some atlases and gazetteers, and from the SiteFinder database. 
 
Some sources give latitude/longtude coordinates in decimal form rather than degrees and minutes. An 
option to change the SiteFinder coordinates from one to the other is provided on the Options menu.   
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Measuring Distance 
 

SHORTCUT KEY: M 
 
 
MEASURE MODE is a very useful feature in cases where you are given a location description such as 
"47 miles NW of Baltimore". The anchor point (in this case, Baltimore) is usually a well-known place for 
which you can find the latitude and longitude coordinates. Having placed that using AniMap's latitude-
longitude tracking, mileage mode makes it easy to place the location of the second place on the map. 

                                                     
 Measure Mode is activated either from the Options Menu of by using the hot key "M". The mileage button 
will appear on the screen and can be re-positioned in the same way as the Latitude-Longitude button. 
Clicking the right mouse button will bring up one of two different cursors depending on whether or not you 
have any markers already on the screen. If you do not have any markers, the cursor will appear as the 
"X" mark which you can move into the desired position and place by clicking the left mouse button. When 
the marker is placed, it will appear as the "anchor on marker" illustrated below 
 
                                              
 
If there is at least one marker on the screen, the cursor will be the anchor ring which is intended to be 
placed over an existing marker to flag it as the anchor. You will not be able to drop it at any place other 
than over an existing marker. It need only be close to being centered over the marker and will lock on to 
the precise position when dropped. 
 
Note that the anchor marker is a ring with four arrows pointing outward. The destination marker is almost 
identical, but with the four arrows pointing inward. 

 
 

The same logic applies to the setting of a destination marker. If there is  an anchor marker on the screen, 
the right mouse button changes the cursor to the destination marker pattern. If there are no other markers 
on the screen, a new marker can be placed, and will be flagged with the destination ring. If there are other 
markers on the screen, the destination cursor must be placed over one of them to flag it as the 
destination. The Mileage Button will give you a continuous reading of the number of miles between the 
anchor and the present cursorposition. The destination marker is also dropped by clicking the left mouse 
button. 
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As with Latitude-Longitude tracking, you can use the arrow keys to move the cursor and the INSERT key 
to place a marker. 
 
Erasing Markers: Clicking the left button over the destination marker will remove the destination ring, but 
will leave the marker in place. Another click will remove the marker. Clicking on the anchor marker will 
remove both the anchor and destination rings. 
 
Often, you will want to plot the direction accurately as well as the mileage. AniMap also provides a 
Bearing Mode which will give you the compass direction expressed both in degrees and the compass 
direction (N, NNE, NE, etc.). This is helpful for old gazetteer listings which give locations such as "27 mi. 
SE Chicago". 
                                               

Bearing Mode    
 

SHORTCUT KEY: A 
 
                                            
When Bearing Mode is selected from the Options Menu, the Mileage and Bearing boxes appear together 
on the screen. As in Mileage Mode, you must select an Anchor Marker before any readings will appear in 
the boxes.When the Anchor has been set, holding down the right mouse button will display a heading in 
degrees in the Bearing Box, and a compass direction. The number followingthe compass direction is the 
variance from the true heading indicated (see example below) 
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SiteFinder Place Name Database 
 

Shortcut Key: F2    
 
 
 
 
Each record gives the place name, the county in which it is (or was) located, and the 
latitude and longitude coordinates for all but a few.  
There are two additional fields, "H" and "S".  
 
The H column is used to indicate places that are designated as Historical. In these 
listings, they indicate places that are no longer in existence.  
 
The "S" field is used to show the source of the information. If the "S" field is empty, the 
information is from the Populated Places list published by the U.S. Geological Survey. 
In addition, the following code letters are used to show the type of feature. 
 
     B: Building - a manmade structure with walls and a roof for protection of people  and (or) materials, but 
not including church, hospital, or school.  
 
     E: Cemetery - a place or area for burying the dead (burial, burying ground, grave, memorial garden).  
 
     W: Church - building used for religious worship (chapel, mosque, synagogue, tabernacle, temple).  
 
     V: Civil - a political division formed for administrative purposes (borough, county, municipial, parish, 
town, township).  
 
     I: Island - area of dry or relatively dry land surrounded by water or low wetland (archipelago, atoll, cay, 
hammock, hummock, isla, isle, key, moku, rock).  
 
     L: Locale - place at which there is or was human activity; it does not include populated places, mines, 
and dams (battlefield, crossroad, camp, farm, ghost  
     town, landing, railroad siding, ranch, ruins, site, station, windmill).  
 
     N: Mine - place or area from which commercial minerals are or were removed from the Earth; not 
including oilfield (pit, quarry, shaft).  
 
     M: Military (historical) - place or facility formerly used for various aspects of or relating to military 
activity.  
 
     K; Park - place or area set aside for recreation or preservation of a cultural or natural resource and 
under some form of government administration; not including  
     National or State forests or Reserves (national historical landmark, national park, State park, 
wilderness area).  
 
     O: Post Office - (Formerly abbreviated as PO) an official facility of the U.S. Postal Service used for 
processing and distributing mail and other postal  
     material.  
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     <Blank> Populated Place - (Formerly abbreviated as ppl) place or area with clustered or scattered 
buildings and a permanent human population (city, settlement, town,  
     village).  
 
     R: Reserve - a tract of land set aside for a specific use (does not include forests, civil divisions, parks). 
This will include some Indian Reservations. 
 
     S: School - building or group of buildings used as an institution for study, teaching, and learning 
(academy, college, high school, university).  
 
     C: Courthouse - Usually indicates the county or parish seat. 
 
Note: The above feature class definitions were furnished by the U.S. Geological Survey with the 
exception of those in italics. 
 
Many of the place names are followed by "v-" and another place name. These are 
variant names, usually obsolete, for the indicated location. 
 
If you have access to the Internet, you may obtain information on geographic features 
not listed in SiteFinder such as rivers, mountains, etc. from a Geographic Server. Easy 
access to one of these can be found in our homepage on the World Wide Web. 
http://www.goldbug.com  
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Plotting SiteFinder Locations in AniMap 
 
 
                            

Scortcut Key: P 
 

 
 
AniMap is linked to a database containing the names, counties and locations for more than one million 
places (past and present) in the United States. These locations may be accurately plotted on the state 
maps in AniMap.To use this function, first select SiteFinder from the Options Menu in AniMap (or press 
F2). This will bring you to the state file in SiteFinder corresponding to the state you have been viewing.  
 
SiteFinder includes Search and GoTo functions to help you locate places quickly. Please view the 
"Searching For Places in SiteFinder" section of the Help Files for information on the search options. When 
you have found a place you want to plot on a map, highlight it with the left mouse button and select Pluck 
from the Options Menu or double-click the left mouse button on your selected location. You may pluck up 
to 20 items. When you have finished with the plucking operation, exit SiteFinder (pressing F2 again will 
do this). Selecting Plot from the AniMap Options Menu will display a list of the places you have plotted: 
                                                  

 
     
To get the Plot List, you must be displaying one of the states for which you have plucked an item. Double-
clicking with the left mouse buttons on one of the items on the Plot List will display the location on your 
map. 
                                 
The place-name label may be moved to another position by holding down the left mouse button and 
dragging it. The arrows (>>) may be removed by a single left-mouse click at the opposite end of the label. 
A second mouse click will place the arrows at the other end of the label. 
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Printing Your Maps 
 
 
 
This option will print the map on the screen to whatever default printer you have set up for Windows.  
 
A Printer Setup option is provided in the File menu. Among your other choices, you can choose between 
Portrait and Landscape mode. For most maps, you will get a larger image in Landscape. 
 
 
Just the map will be printed; not the control buttons. You also have the option of printing the list of 
counties with their abbreviations for any given year.  

                
 

A third printing option will allow you to print the map and the county code list on the same page (if space 
permits). States with many counties, Texas for example, will run over to a second page. AniMap 
automatically sets your printer in Portrait Mode if you select this option. 
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Exporting Your Maps to Use in Other Programs 
 
    
When you have a map on the screen, you can choose to export it using this option. It will be placed in a 
bitmap (.bmp) file which can be used in virtually any Windows application. The exported map will have a 
filename like "AL1825XP.BMP". The first two letters indicate the state (Alabama), the numbers are the 
year, XP indicates that it is an exported map.  
 
If you export more than one map for the same state and year, you will need to change the name to avoid 
deleting a map you have previously saved. To do this, highlight the letters XP in the Subscript box (see 
above) and type in whatever letters or numbers you wish to identify your map. 

                           
The county code list may also be exported for use in your word processing software. The exported file for 
the above map, for instance, would be AL1825XP.TXT. 
 
All exported files will be placed in a subdirectory of ANIMAP called EXPORTS. 
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Shortcut Keys 
 
 
 
To make the operation of AniMap easier, we have created "Hot Keys" for several of the often-used 
functions. You can activate the following functions by pressing the key indicated while maps are displayed 
on your screen: 
 
     Latitude-Longitude Tracking: L 
     Overlay Menu: Y 
     Mileage Mode: M 
     Plot List: P 
     Bearing Mode: A 
     Help Files: F1 
 
F2 while in AniMap takes you to the SiteFinder database 
F2 while in SiteFinder, exits and returns you to AniMap  
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File Names Explained 
 
 
 
State abbreviations have been used in the file names which mostly conform to the postal abbreviations 
for those states. The exceptions are MA which includes Massachusetts, Rhode Island and Connecticut. 
MD which includes Maryland Delaware and the District of Columbia. NH which includes New Hampshire 
and Vermont. And VW which is Virginia and West Virginia. 
 
Alabama   AL                   Arizona   AZ                          Arkansas   AR 
California   CA                 Colorado   CO                        Connecticut   MA 
Delaware   MD                 Florida   FL                            Georgia   GA   
Idaho   ID                        Illinois   IL                               Indiana   IN     
Iowa  IA                           Kansas   KS                           Kentucky  KY      
Louisiana   LA                 Maine   ME                             Maryland   MD    
Massachusetts   MA        Michigan   MI                          Minnesota   MN    
Mississippi   MS              Missouri   MO                         Montana   MT         
Nebraska   NE                 Nevada   NV                            New Hampshire   NH   
New Jersey   NJ               New Mexico   NM                    New York   NY            
North Carolina   NC          North Dakota   ND                    Ohio   OH                   
Oklahoma   OK               Oregon   OR                             Pennsylvania   PA        
Rhode Island  MA            South Carolina   SC                  South Dakota  SD         
Tennessee  TN                Texas   TX                                Utah   UT                     
Vermont  NH                   Virginia   VW                            Washington   WA         
West Virginia   VW          Wisconsin   WI                         Wyoming   WY 
 
 
Map files for AniMap are in a directory titled DLL.  Each state has two map files, with titles like 
Maplbbxx.dll and Maplibxx.dll.  "xx" indicates the state name from the above list. 
 
The database file for SiteFinder are in a folder titled DBF. Filenames will be Sfindxx.dbf. "xx" indicating 
the state name from the list above. The exported state files will have names like MAPZxx.ZP2. "xx" 
indicates the state abbreviation. So, MAPZAL.ZP2 would be the map file for Alabama. 
 
Overlay files will be named xxOVLAY#.BMP. "xx", again, is the state abbreviation and "#" being a 
sequential numbering between 1 and 9. The first overlay for Alabama, for example, would be 
ALOVLAY1.BMP. Overlay names must be correct for the program to detect them. Numbers must be 
consecutive, beginning with 1 for AniMap to detect all the overlays. 
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Technical Support 
 
 
                            
 
If you have problems with AniMap and need assistance, we may be reached by phone, e-mail or fax. 
 
Online help is also available by addressing e-mail to: GOLDBUG@AOL.COM (this is the most reliable 
way to contact us). 
 
Phone: 866-784-3923 
 
Or by Fax to 925-314-9332 
 
Updated information on AniMap will be available at times on our World Wide Web homepage: 
http//www.goldbug.com 
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Interesting Things on our Website 
 
 
                                   

http://www.goldbug.com 
 
 
- Updated information about AniMap , SiteFinder and our other products can be found on our homepage. 
We also provide some other resources you may find useful and interesting. 
 
- Direct links  to Geographic Servers for the United States and most other countries where you can search 
for the locations of several million places including towns, rivers, mountains, and much more. 
 
- Links to other homepages with geographic and historic information. 
 
- SiteFinder Online which will plot locations from our Sitefinder database on Google Maps. View them 
either in map form, satellite view or a combination of both.  
 


